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Customer comments

Waters’ Technical Communications department invites you to tell us of any 
errors you encounter in this document or to suggest ideas for otherwise 
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documentation so that we can continuously improve its accuracy and 
usability. 
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Contacting Waters

Contact Waters® with enhancement requests or technical questions regarding 
the use, transportation, removal, or disposal of any Waters product. You can 
reach us via the Internet, telephone, or conventional mail.

Breeze 2 Software

Intended use
Use the Waters Breeze 2 Software for acquiring, processing, reporting, and 
managing your chromatographic information.

Safety information
See the operator’s guides of the instruments or devices associated with this 
software product for information on how to safely operate and maintain them.

Waters contact information:

Contacting medium Information
Internet The Waters Web site includes contact 

information for Waters locations worldwide. 
Visit www.waters.com.

Telephone and fax From the USA or Canada, phone 800 
252-HPLC, or fax 508 872 1990.
For other locations worldwide, phone and fax 
numbers appear in the Waters Web site.

Conventional mail Waters Corporation
34 Maple Street
Milford, MA 01757
USA
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1 Introduction

This chapter describes Waters® Breeze® 2 software, the hardware and 
software needed to work with Breeze 2, and the types of 
chromatographic devices supported.
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Waters Breeze 2 software

The Waters Breeze 2 Software system includes these elements:
• Chromatographic instrumentation
• Chromatographic data acquisition and data processing computer
• Breeze 2 software, a 32-bit data acquisition and management software 

application with advanced integrated database architecture
The system acquires, processes, reports, and manages chromatographic 
information. Breeze 2 offers easy-to-use technology and converts high-quality, 
accurate results into usable information. It is a complete chromatography and 
results management system that you can adapt to your individual 
chromatography requirements by using as many or as few Breeze 2 software 
capabilities as you require.

Typical system configuration

Breeze 2 operates in a workstation configuration. The following figure shows a 
typical Breeze 2 workstation configuration.

Typical Breeze 2 workstation configuration

Breeze 2 workstation

Waters 2707 
autosampler

eSAT/IN 
module

Chromatographic system

Waters 2489 UV 
detector

Non-Waters 
Detector

Waters 1500 series 
pump

Printer
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Hardware and software requirements

The following table describes the hardware, software, and operating system 
requirements for the Breeze 2 workstation.  

Devices supported by Breeze 2

Breeze 2 can support these devices:
• Ethernet devices
• Up to 14 IEEE-488-based devices (within cable length guidelines). For 

more information, see “Connecting IEEE-488 chromatographic devices” 
on page 2-4.

• As many as four busSAT/IN™ modules, through a busLAC/E card via an 
I/O distribution box

Requirements for Breeze 2 workstation computer 

Component Minimum
Operating system/
hardware

Windows® Vista Business with Service Pack 1, 32-bit
Intel® Core 2 Duo, 2.13 GHz CPU

Random access 
memory (RAM)

2 GB

Hard disk drive 50 GB
DVD drive Access to a DVD drive required
Monitor Required
Graphics capability sVGA video at 1024 × 768 × 16 bit color resolution
Printer Access to a printer required
Optional control card Waters Bus Laboratory Acquisition and Control/ 

Environment (busLAC/E™) card
Application software Breeze 2 software
Network interface 
card

Recommended
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Breeze 2 does not support mixed IEEE-488 and Ethernet configurations. 
Breeze 2 requires one of these network configurations:

• All system modules communicate with the data system through an 
IEEE-488 connection.

• All system modules communicate with the data system through an 
Ethernet connection.

The following tables list the minimum firmware versions of the devices 
supported by Breeze 2 at the time of its release.

Ethernet instruments

Device type Device Supported firmware 
version1

1. You can find the firmware revision number on the instrument specification plate or front 
panel display.

Detectors Waters 2414 Refractive Index 
(RI) Detector

2.04

Waters 2420 Evaporative Light 
Scattering Detector

1.00.1057 and above

Waters 2424 Evaporative Light 
Scattering Detector

1.20.3743 and above

Waters 2475 Multi λ 
Fluorescence Detector

2.01

Waters 2489 UV/Visible Detector 1.30.1848 and above
Waters 2998 PDA Detector 1.30.4967 and above

Pumps Waters 1525 and 1515 Pumps 3.00

Waters 1525μ and 1525EF 
Pumps

3.00

Autosamplers Waters 2707 Autosampler 1.00.1206 and above
Interfaces and 
Accessories

Temperature control system II 
(TCM II)

3.02

Waters Pump Control Module II 
(PCM II)

4.00

Waters 1500 Column Heater 1.02
Waters e-SAT/IN Module 1.10.1015 and above
1-4 Introduction



Before you install an IEEE-488 device in the Breeze 2 system, verify that the 
firmware of the device is the minimum version listed in the following table.

Supported IEEE-488 devices

Device type Device Supported firmware 
version1

1. You can find the firmware revision number on the instrument specification plate or front 
panel display.

Pumps Waters 515 pump (with PCM or 
PCM II)

1.5

Waters 1525 and 1515 pumps 
(with PCM or PCM II)

2.02

Waters 1525μ and 1525EF 
pumps (with PCM or PCM II)

2.11

Interfaces and 
Accessories

Waters Temperature Control 
Module (TCM)

2.1

Waters Temperature Control 
Module II (TCM II)

3.0

Waters Pump Control Module 
(PCM)

2.2

Waters Pump Control Module II 
(PCM II)

3.0

Waters 1500 Column Heater 1.02
Waters Bus SAT/IN Module 20

Detectors Waters 410 Refractive Index 
Detector

4.30

Waters 2410 Refractive Index 
Detector (appears as 410)

5.1

Waters 2414 Refractive Index 
Detector (2410 emulation mode)

1.0

Waters 2487 Dual λ Absorbance 
Detector

1.01

Autosamplers Waters 717plus Autosampler 3.1
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Optional interface cards
Breeze 2 supports these optional interface cards:

• Network interface card for Ethernet instruments
• busLAC/E (IEEE-488 interface) card for connecting Waters IEEE-488 

devices

Network interface card for Ethernet instruments

A Breeze 2 workstation can use a network interface card (NIC) to 
communicate with Ethernet instruments. Refer to the Waters Ethernet 
Instrument Getting Started Guide for detailed information.

busLAC/E card

The busLAC/E card is a microprocessor-based interface card that transmits 
commands from Breeze 2 software to detectors, autosamplers, pumps, and 
other devices over the IEEE-488 and custom interfaces via an IEEE-488 cable. 
Data from the devices are transmitted through the busLAC/E card to the 
computer for analysis.
The Breeze 2 workstation can use a busLAC/E card to function with Breeze 2. 
Chromatographic devices can connect to the busLAC/E card.

The busLAC/E card performs two primary functions:
• Acquires data from a detector and transmits the data to the computer
• Controls chromatographic devices

The maximum total aggregate data rate depends on the instrument type:
• For all detectors connected to the busLAC/E card, a maximum total 

aggregate data rate of 400 points per second is supported.
• For each busSAT/IN™ connected to the busLAC/E card, a maximum 

total aggregate data rate of 100 points per second (50 points per 
channel) is supported.
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2 Installing and configuring the 
hardware

This chapter tells you how to install and configure the hardware for the 
Waters Breeze 2 software system.
If your Waters technical service representative has already installed and 
configured the system for you, proceed to “Powering-on the system” on 
page 2-12.
Recommendation: Before installing any hardware or software, perform 
a full backup of your hard drives (see the instructions provided by the 
manufacturer of your computer).
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Selecting the site

Locate the Breeze 2 system in a clean area, free from shock, vibration, and 
extremes of temperature and humidity.

Environmental requirements
The Breeze 2 system is designed to operate within the following temperature 
and humidity ranges:

• Temperature: 10 to 31°C (50 to 88°F)
• Humidity: 20 to 80% relative humidity, noncondensing, maximum wet 

bulb of 25°C and minimum dew point of 2°C
Acceptable temperature and humidity ranges vary according to the model of 
computer and printer.
Protect equipment from direct sunlight, heat registers, or air conditioning 
vents.

Bench space
Allow sufficient bench space for the Breeze 2 workstation (keyboard, monitor, 
system unit, and printer) as recommended in the documentation supplied 
with the computer. You can place the computer on the lab bench or on a 
desktop near the chromatography instrumentation. The total bench space you 
require depends upon the number of devices you plan to configure (pumps, 
detectors, autosamplers, eSAT/IN modules, and so on).

Cable lengths
You can connect up to 14 IEEE-488-based devices to the Breeze 2 system. To 
ensure proper signal transmission, arrange the components of your 
chromatographic system to minimize cable lengths. Always follow the cable 
length guidelines listed in “Making cable connections” on page 2-6.

Instrument arrangement
Make sure the ventilation slots on all instruments are not blocked. Allow at 
least 15 cm (6 inches) of space on all sides of each instrument to ensure 
adequate air flow.
For information on the best arrangement of your Breeze 2 system and 
connected instruments, consult your Waters technical service representative.
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Installing and configuring the computer system

This section describes the process for installing and configuring the Breeze 2 
computer system and other components.

To install and set up the Breeze 2 workstation

1. Unpack and place the workstation in the desired location.

2. Attach the keyboard, mouse, and monitor to the workstation.

3. To install other computer peripherals, such as a printer, see the 
installation documentation supplied with the device.

4. Connect and configure the serial or Ethernet devices (see “Connecting 
Ethernet devices” on page 2-3).

5. Ensure that the busLAC/E (IEEE-488 interface) card is installed in the 
workstation and is set up correctly.

6. Connect the IEEE-488 chromatography instruments to the busLAC/E 
card in the workstation using the IEEE-488 cable (see “Connecting 
IEEE-488 chromatographic devices” on page 2-4).

7. Power-on the workstation (see “Powering-on the system” on page 2-12).

Connecting Ethernet devices

Ethernet instruments connect directly to the network interface card in the 
computer. If you are connecting multiple Ethernet instruments, use a 
Waters-supplied switch to connect the Ethernet cable from the computer to 
the switch, and then plug each instrument into the switch.

Triggering of devices, such as 2489, 2998, 2414, and 2424 detectors, occurs 
over the Ethernet cable and so requires no external trigger cables.
Exception: Waters 2475 Fluorescence Detector, V2.02 requires an external 
trigger cable under Ethernet control.
You must assign an IP address to the network interface card and enable 
DHCP so that it can assign IP addresses to your Ethernet instruments.

Caution: The Breeze 2 system does not support the use of an Ethernet 
hub.
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To set the network card IP address

Requirement: Breeze 2 software must first be installed on the workstation.

1. From the Manage menu, select Systems.

2. In the Manage Systems dialog box, click Node Properties.

3. On the Instruments tab of the Breeze 2 Node Properties page, configure 
the IP address. For details, see the Ethernet Instrument Getting Started 
Guide or see the topic “Configuring chromatographic instruments” in the 
Breeze 2 Help.

Connecting serial devices

You can use a busSAT/IN module to collect the analog output signals of non- 
IEEE-488 devices (such as non-Waters detectors). A busSAT/IN module 
converts the analog output signals to digital signals then transmits them to 
the busLAC/E card, via an I/O distribution box. Supported serial 
chromatography devices connect through an I/O distribution box or a PC COM 
port.

Connecting IEEE-488 chromatographic devices

The IEEE-488 bus is an instrument interface that connects devices using one 
communication protocol. In the Breeze 2 system, the IEEE-488 interface 
connects Waters IEEE-488 chromatography devices to the busLAC/E card.
The busLAC/E card is an instrument controller that assigns the role of active 
“talker” or “listener” to each attached device on the IEEE-488 bus. Each 
instrument designated as an active talker supplies information to the other 
devices on the IEEE-488 bus. Each device designated as a listener receives 
information from an active talker device. Only one active talker is allowed at a 
time, but several listeners can be active simultaneously.
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busLAC/E card connections
The busLAC/E card connects to peripheral devices through two ports on the 
rear edge of the card as follows:

• IEEE-488 port – Used for connecting to IEEE-488-controlled devices 
such as the Waters 717plus Autosampler and the Waters 2487 Dual λ 
Absorbance Detector

• Serial port – Used for connecting to serial devices, such as the Waters 
busSAT/IN Module, via an I/O distribution box.

Tip: For a complete list of devices and firmware supported by the Breeze 2 
system, see “Devices supported by Breeze 2” on page 1-3.
An IEEE-488 cable connects the 2487 absorbance detectors and other 
IEEE-488 devices to the busLAC/E card.
The I/O distribution box connects to the busLAC/E card. BusSAT/IN modules 
communicate with the busLAC/E card through the I/O distribution box over 
serial cables. The I/O distribution box allows you to connect as many as four 
busSAT/IN modules, each of which can connect to two analog detector outputs.

busLAC/E card port connections

Triggering of devices, such as 2487, 2414, and 2410 detectors, occurs over the 
IEEE-488 cable and so requires no external trigger cables.

To busSAT/IN Module 
(Optional)
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Making cable connections
The Breeze 2 system supports the Waters IEEE-488 devices listed in the table 
on page 1-5.
When connecting IEEE-488 devices, observe these guidelines:

• The maximum number of devices that you can connect to form one 
interface system is 15 (14 instruments plus the busLAC/E card).

• Arrange the components of your chromatographic system to minimize 
cable lengths.
– The maximum cable length between two devices is 4 meters (13 

feet).
– The minimum cable length between two devices is 1 meter (3.25 

feet)

– The maximum total cable length connecting the devices and the 
busLAC/E card in one interface system is 2 meters (6.5 feet) 
multiplied by the number of devices, or 20 meters (65 feet), 
whichever is smaller (see the table below).

Caution: Cable lengths greater than the maximum values or less 
than the minimum values can cause IEEE-488 communication 
failures.

Maximum cable lengths for IEEE-488 devices

Number of devices 
connected

Maximum total 
cable length 
(meters)

1 4
2 6
3 8
4 10
5 12
6 14
7 16
8 18
9-14 20
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To connect IEEE-488 devices

1. Connect the single-receptacle end of the in-line IEEE-488 cable 
(supplied with the Breeze 2 system) to the busLAC/E card.

Example of IEEE-488 cable connections

2. Connect the other end of the IEEE-488 cable (with the stackable 
connector for daisy-chaining additional instruments) to the IEEE-488 
connector on an instrument.

3. Use one end of another IEEE-488 cable to connect to the stackable 
connector on the first instrument. Connect the other end of the cable to 
the IEEE-488 port on the next instrument.

4. Repeat step 3 for each additional instrument, up to 14 IEEE-488 
instruments. See the table titled “Maximum cable lengths for IEEE-488 
devices” on page 2-6 for cable-length limitations.
Tip: The order in which you connect IEEE-488 devices to the busLAC/E 
card is not important. For example, you can connect the injector before 
or after the detector.

5. Ensure that all IEEE-488 cable connector screws are finger-tight.

PCM/152
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Making device connections

PCM connections

The Waters Pump Control Module (PCM) is an IEEE-488 device that controls 
the 500- and 1500-series pumps. Connect the PCM to the IEEE-488 bus.
Note: You can connect the PCM II through the Ethernet or IEEE-488 
interface.

TCM connections

The Waters Temperature Control Module (TCM) is an IEEE-488 device that 
regulates the temperature of as many as three column heaters. Connect the 
TCM to the IEEE-488 bus.
Note: You can connect the TCM II through the Ethernet or IEEE-488 
interface.

Injector connections

Manual injectors require an inject-start trigger wire connection. The 
inject-start trigger signal (contact closure) instructs detectors and system 
controllers to acquire data or run methods.
Waters autosamplers transmit the inject-start signal over the IEEE-488 bus 
or by trigger wire.
If you connect a Waters 717plus Autosampler to an IEEE-488 interface, you 
need not make additional connections for an inject-start signal. When under 
IEEE-488 control, the 717plus transmits the inject-start signal directly over 
the IEEE-488 bus during data acquisition. All controlled devices are triggered 
simultaneously when an injection is made by these instruments.
Trigger wires are not required when all instruments in a chromatographic 
system are controlled over the IEEE-488 bus.

Detector connections

Detectors with an installed IEEE-488 interface can be connected directly to 
the busLAC/E card.
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Setting IEEE-488 device addresses
You must set a unique address for each device connected on the IEEE-488 bus 
so that the busLAC/E card recognizes each device. Valid IEEE-488 instrument 
addresses are 2 through 29.
Recommendation: Use IEEE addresses 9 and above, spacing the addresses by 
a difference of 2. Example: 9, 11, 13, and so on.
Set the IEEE-488 addresses of the Waters instruments in your system 
through either the software (accessed from the front panel of the instrument) 
or DIP switches.

Setting IEEE-488 addresses using software

To set an IEEE-488 address using software, set the address from the front 
panel of the device. See the operator's guide for a particular device for detailed 
instructions on setting the IEEE-488 address.

Setting IEEE-488 addresses using DIP switches

For the 1500 series pump, 1500 series column heater, 410 detector, PCM, 
TCM, and Bus SAT/IN, use the DIP switches to set the IEEE-488 address.
The following figure shows the arrangement of DIP switches on a DIP switch 
block (on the rear panel of a device).

Setting IEEE-488 addresses

Instrument IEEE-488 address set by
1500 series pumps DIP switches
1500 series column heater DIP switches
410 detector DIP switches
2410 detector Software
2487 detector Software
717plus autosampler Software
PCM DIP switches
TCM DIP switches
Bus SAT/IN DIP switches
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DIP switch block

To set an IEEE-488 address from a DIP switch

1. Ensure that no instruments are connected to the busLAC/E card.

2. Power-off the IEEE-488 device.

3. Using the DIP switches on the rear panel of the device (see the figure, 
above), set a unique IEEE-488 address for the device.
Tip: Although there are 28 valid addresses (2 through 29), IEEE-488 
protocol allows up to 14 devices.
Set the IEEE-488 address according to the table below.

4. Power-on the device.

Settings for the Waters 1500 series pumps, 410, PCM, and TCM

IEEE-488 
address

DIP switch settings1

1 2 4 8 16
2 OFF ON OFF OFF OFF
3 ON ON OFF OFF OFF
4 OFF OFF ON OFF OFF
5 ON OFF ON OFF OFF
6 OFF ON ON OFF OFF
7 ON ON ON OFF OFF
8 OFF OFF OFF ON OFF
9 ON OFF OFF ON OFF
10 OFF ON OFF ON OFF
11 ON ON OFF ON OFF
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Scanning the IEEE-488 bus

After you set the IEEE-488 address for a device, the busLAC/E card must scan 
the IEEE-488 bus. To scan the IEEE-488 bus, see “Configuring 
chromatographic instruments” in the Breeze 2 Help.

12 OFF OFF ON ON OFF
13 ON OFF ON ON OFF
14 OFF ON ON ON OFF
15 ON ON ON ON OFF
16 OFF OFF OFF OFF ON
17 ON OFF OFF OFF ON
18 OFF ON OFF OFF ON
19 ON ON OFF OFF ON
20 OFF OFF ON OFF ON
21 ON OFF ON OFF ON
22 OFF ON ON OFF ON
23 ON ON ON OFF ON
24 OFF OFF OFF ON ON
25 ON OFF OFF ON ON
26 OFF ON OFF ON ON
27 ON ON OFF ON ON
28 OFF OFF ON ON ON
29 ON OFF ON ON ON

1. ON = Closed or 1. OFF = Open or 0.

Settings for the Waters 1500 series pumps, 410, PCM, and TCM (Continued)

IEEE-488 
address

DIP switch settings1

1 2 4 8 16
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Powering-on the system

This section contains the startup sequence for the Breeze 2 system and its 
peripheral equipment.
Powering-on the Breeze 2 system entails powering-on the individual 
instruments and devices in a particular sequence.
Always observe these power guidelines:

• Keep all devices powered-on while your system is in use.
• While a system is active on the IEEE-488 bus, do not power-on or 

power-off any device on the bus.

To power-on instruments and devices

1. Power-on all equipment controlled through the IEEE-488 bus, waiting 
until any internal diagnostic tests finish.
Restriction: You cannot run methods or use Run Samples unless all 
devices on the IEEE-488 bus that are assigned to a Breeze 2 system are 
powered-on and have successfully completed any calibration tests.
Requirement: Power-on the pumps of an LC system first, to establish a 
flow before powering-on the detectors. Do not power-on (or power-off) 
instruments connected to a bus running any systems.

2. Power-on the computer.

3. Power-on all equipment controlled by the Breeze 2 system that is not 
under IEEE-488 control; that is, all equipment controlled through the 
I/O distribution box (busSAT/IN Modules and connected analog 
detectors).

4. Power-on all equipment not controlled by the Breeze 2 system (for 
example, computer peripherals such as printers).

Caution: Ensure that the computer’s power supply is set to the 
correct voltage for your site. If it is set incorrectly, your computer 
can be damaged.
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3 Installing and configuring the 
software

This chapter explains how to install Breeze 2 software on a Breeze 2 
workstation.
Recommendation: Before installing any hardware or software, perform 
a full backup of your hard drives (see the instructions provided by the 
manufacturer of your computer).
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Requirements

Complete these tasks before you begin the installation:

1. Ensure the workstation has the required hardware and software, as 
specified in the table titled “Requirements for Breeze 2 workstation 
computer” on page 1-3.

2. Log in to the operating system using an account with Administrator 
privileges.

3. Back up and defragment the hard drive (see the Microsoft 
documentation and Help system) to ensure smooth installation of and 
optimum performance from Breeze 2.

4. Configure Windows Vista so that the virtual memory setting 
automatically manages the paging file size.

5. Close all applications, and then restart the workstation.

6. Verify that the hard drive has at least 7000 MB (7 GB) of free space, to 
accommodate the added software.

When you start the installation, the combined free disk space of all local 
drives must equal or exceed 7 GB. The installation stops if you are not in an 
administrator group account, the operating system is unsupported (for 
example, Windows XP), available memory is less than 256 MB, or Windows 
Vista Business is not updated with the correct service pack.

Installing Breeze 2 software

You install Breeze 2 software from the Breeze 2 DVD. You can perform a 
typical installation to install the software on the C-drive or default location, or 
a custom installation to specify a different drive. Allow approximately 30 
minutes to install the software.

Starting the installation

To install Breeze 2

1. Insert the Breeze 2 DVD into the DVD drive.

2. Browse to the Breeze2 folder on the DVD, right-click the 
Breeze2setup.exe file, and then select “Run as administrator”.
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3. On the Choose Setup Language page, select a language from the 
drop-down list, and then click OK.
Requirement: If Microsoft .NET Framework 3.0 software is not installed 
on your system, the Requirement wizard page appears. On that page, 
you must click Install.

4. On the Welcome page, click Next.

5. On the License Agreement page, accept the license agreement, and then 
click Next.

6. On the Customer Information page, enter your user name, organization, 
and serial number, and then click Next.

7. On the Setup Type page, leave Typical selected, and then click Next.
Alternative: Select Custom if you want to install the software on a drive 
other than C, then continue with the next section, “Finishing a custom 
installation”.

8. On the Ready to Install the Program page, click Install to start the 
installation.
Result: The Breeze 2 Setup wizard installs the Breeze 2 and Oracle 
program files on the hard drive. This process can take several minutes.

9. On the Install Shield Wizard complete page, click Finish.

10. Click Yes at the next page to restart the workstation and then continue 
with “Completing the installation” on page 3-4.

Finishing a custom installation
If you selected Custom in step 7 of “Starting the installation”, complete the 
installation as follows.

To finish a custom installation

1. On the Custom Setup page, specify the program features you want to 
install.
Tip: By default, the “Install to” location points to drive C.
To designate drives other than drive C, click an icon (for example, 
Breeze 2 Oracle Files and Database), and then click the Change Feature 
Location button.
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2. On the Change Current Destination Folder page, select the desired 
drive, and then click OK to return to the Custom Setup page. 

3. Repeat step 2 for all feature locations, and then click Next.

4. On the Ready to Install the Program page, click Install to start the 
installation.
Result: The Breeze 2 Setup wizard installs the Breeze 2 and Oracle 
program files on the hard drive, a process that can take several minutes.

5. On the Install Shield Wizard complete page, click Finish.

6. Click Yes at the next page to restart the computer, and then continue 
with the next section.

Completing the installation
After the computer restarts, complete the installation:

• Log in to the operating system using an account with Administrator 
privileges.
Tip: The account must be the same one that you logged in to when 
starting the installation.

• If your system includes a busLAC/E card, you must install and configure 
the busLAC/E driver for Breeze 2. Follow the procedure in the next 
section, “Installing and configuring a busLAC/E driver” on page 3-5.

• If you want to install software support for one or more Ethernet 
instruments, use the Waters Instrument Control Options Pack (ICOP) 
setup program, located on the Breeze 2 media:
1. Browse to the appropriate language folder on the DVD and locate 

the setup.exe file.
2. Right-click the file, and then select “Run as Administrator.” 
3. Follow the prompts to install the software support you need.

• Install the Breeze 2 license (see “Installing the Breeze 2 license” on 
page 3-6).

• Verify the installed files (see “Verifying installed files” on page 3-8).
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Installing and configuring a busLAC/E driver

After you install Breeze 2, install and configure the busLAC/E driver.
Requirement: Insert the Breeze 2 disk into the computer’s DVD drive before 
beginning this procedure.
Tip: If the Found New Hardware Wizard dialog box appears automatically, 
start with step 5. If the dialog box fails to appear, follow the procedures for 
accessing the wizard manually.

To install and configure the busLAC/E driver

1. From the Start menu, right-click Computer, and then select Manage.

2. On the Computer Management page, click Computer Management 
(Local) > System Tools > Device Manager. 

3. In the right-hand pane, locate System devices> PCI Device.

4. Right-click PCI Device, and then select Properties.

5. In the General tab on the PCI Device Properties page, click the Reinstall 
Driver button.

6. On the Found New Hardware - PCI Device page, select "Browse my 
computer for driver software (advanced)".

7. Under “Browse for driver software on your computer”, click the Browse 
button, and navigate to the BuslaceDrivers folder on the Breeze 2 DVD.

8. Select the checkbox “Include subfolders” and then click Next.

9. When the Windows security message “Would you like to install this 
device software?” appears, click Install.

10. When the installation is complete, restart your computer.
Result: The BusLAC/E driver is installed appearing as “Buslace PCI 
KMDF Device Driver”, under BusLAC/E Drivers in Device Manager.
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Installing the Breeze 2 license

About licenses
You use the Waters Software License Management System to manage the 
Breeze 2 software license. You must install the Breeze 2 software license to 
access the Breeze 2 software. The Breeze 2 serial number purchased from 
Waters is required for activating or deactivating the Breeze 2 license through 
the Waters Licensing Wizard.
For each Breeze 2 License you install, you can create five active user accounts 
on the Breeze 2 workstation. Breeze 2 also includes a default “breeze” user 
account for you to use when you initially log on. No password is required.
To view active licenses, use the Show Licenses option in the Waters Licensing 
Wizard.
If you need to transfer a license from one Breeze 2 workstation to another, you 
must deactivate it from the original workstation before you activate it in a 
new workstation.

To install the Breeze 2 software key

1. Log in to the workstation (where you installed Breeze 2) as an 
administrator user.

2. From the Start menu, click Start > All Programs > Breeze 2 > Waters 
Licensing Wizard.

3. On the task page, click “Request software registration”.

4. On the “Request software registration – Create registration file” page, 
enter a valid name and location for your software registration file, and 
then click Next.
Tip: This file stores your software registration information.

Caution: Do not uninstall Breeze 2 software until after you uninstall 
the license. Otherwise the license becomes unusable.
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5. When the “Request software registration – Registration file created” 
page appears, click the address link.
Tip: If your computer has Internet access, it connects to the Waters 
License Activation Center Web site where you complete the request 
process and receive your license activation file.
If your computer does not have Internet access, move the software 
registration file that you just created to a computer with Internet access 
so you can relay your request to Waters. Connect to the Waters License 
Activation Center Web site. Follow the instructions to activate your 
license. After you receive the license activation file from the Web site, 
move the file back to the Breeze 2 computer so that you can activate 
your license.

6. Go to the Waters Licensing Wizard task page, and select Activate 
Licenses.

7. Select the license activation file you downloaded from the Waters 
License Activation Center Web site, and then click Next.
Requirement: You must complete the activation process using the 
Breeze 2 computer on which you created the software registration file.

8. Click Finish.
Result: The License Activation Complete page indicates that the Breeze 
2 license is successfully activated.

Uninstalling the Breeze 2 license
If you want to transfer the Breeze 2 license from one workstation to another, 
you must first uninstall the license from its current workstation using the 
Waters Licensing Wizard.

To uninstall a license

1. Log in to the workstation (where you installed Breeze 2 software) as an 
administrator user.

2. From the Start menu, click Start > All Programs > Breeze 2 > Waters 
Licensing Wizard.

3. On the task page, click Deactivate Licenses.

4. On the “Deactivate Licenses – Select Licenses” page, select the license 
you want to deactivate, and then click Next.
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5. On the “Deactivate Licenses – Create deactivation file” page, enter a 
valid name and location for your license deactivation file. 
Tip: This file stores your license deactivation information.

6. Click Next.
7. When the “Deactivate Licenses – Deactivation file created” page 

appears, note the file location, and then click the address link.
Tip: If your computer has Internet access, it connects to the Waters 
License Activation Center Web site, where you complete the 
deactivation process.
If your computer does not have Internet access, move the license 
deactivation file that you just created to a computer with Internet access 
so that you can relay your request to Waters.

8. On the Waters License Activation Center Web site, select Deactivate 
Licenses, and follow the instructions to deactivate your license.
Requirement: Load the license deactivation file created in step 7.
When the process is complete, a confirmation page appears that lists the 
deactivated license.

Verifying installed files

The Breeze 2 Setup wizard creates a Breeze 2 program folder in the Start 
menu. The Breeze 2 program folder contains these items:

• Breeze 2 – Starts the Breeze software and displays the Breeze 2 Login 
page. After you log in, you can select one of several Breeze 2 
applications. For details, see “Starting and exiting from Breeze” in the 
Breeze Help.

• Breeze 2 Help– Starts the online help application.
• Breeze 2 Installation Log – Contains information about the current 

installation.
• Verify Files – Verifies the integrity of the Breeze software files on your 

hard disk.
• File Verification Results – displays the results of the file verification 

utility in a text file.
• Waters Licensing Wizard – Starts the Waters Licensing Wizard, which 

you can use to request software registration, activate and deactivate 
licenses, or view Waters licenses and their serial numbers.
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Viewing the installation log
The installation log contains information about your Breeze 2 installations. 
You can read the log file to review your installation choices. In case of a partial 
or unsuccessful installation, you can review the installation log to check for 
errors.

To view the installation log

1. Click Start > All Programs > Breeze 2 > Installation Log.
Result: The program displays the Breeze.log file in Notepad.

2. Review the contents of the Installation Log file.

3. Click File > Exit.

Using the file verification utility
The file verification utility checks the integrity of the installed Breeze 2 
program, data files, and database files, ensuring that the Breeze 2 files did not 
change since installation.
After the installation, run the file verification utility to verify the Breeze 2 
software program files.

To run the file verification utility

1. Click Start > All Programs > Breeze 2 > Verify Files.
Result: The file verification utility compares the installed Breeze files 
checksum with a previously stored checksum and then creates a file 
verification results log.

2. Review the contents of the file. Print or save a copy of the results.

3. Click File > Exit.

Checking for Breeze 2 service packs

Waters periodically releases service packs to address existing issues or to 
provide enhanced functionality. Available for downloading from the Waters 
Elite Web site, you install them according to the instructions contained in 
their associated release notes. If you want physical media, note the part 
number from the Web site and contact your local Waters subsidiary to place 
an order.
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